Introduction

FERPA Information

Banner Basics | Fundamentals
User Log In
General Person (SPAIDEN)
Name Search (SOAIDEN)

Departmental Users:
Admissions:
Admissions Application Summary (SAASUMI)
Prior College Summary (SOAPCOQ)
Test Score Information (SOATEST)
High School Information (SOAHSCH)
Attributes (SGASADD)

Registrar’s Office:
Viewing a Student’s Information (SGASTDQ)
Programs | Majors | Minors (SGASTDN/SZAREGS)
Assigning Advisor (SGAADVR)
Attributes (SGASADD)
Class Schedule | Section Detail (SSASECQ|SSASECT)
Linked Sections (SSASECT|SSADETL)
Overrides (SFASRPO)
Holds (WOAHOLD)
Course Summary (SHACRSE)
Term History (SHATERM)
GPA by Subject (SHASUBJ)
Transfer Work (SHATRNS)
My Banner (GUAPMNU)
Using Self Service Banner (SSB)

References
Quick Tips

Common Function

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Block</td>
<td>[Ctrl + Pg Down]</td>
</tr>
<tr>
<td>Roll Back</td>
<td>[Shift + F7]</td>
</tr>
<tr>
<td>Execute Query</td>
<td>[F8]</td>
</tr>
<tr>
<td>Direct Access</td>
<td>[F5]</td>
</tr>
<tr>
<td>Enter Query</td>
<td>[F7]</td>
</tr>
<tr>
<td>Save</td>
<td>[F10]</td>
</tr>
<tr>
<td>Exit</td>
<td>[Ctrl + Q]</td>
</tr>
</tbody>
</table>

INB and SSB

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INB</td>
<td>Internet Native Banner</td>
</tr>
<tr>
<td>SSB</td>
<td>Self Service Banner</td>
</tr>
<tr>
<td></td>
<td>Faculty/Advisor Tab</td>
</tr>
</tbody>
</table>

Wildcards

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%</td>
<td>Multiple Character Search</td>
</tr>
<tr>
<td>_</td>
<td>Single Character Search</td>
</tr>
</tbody>
</table>

INB and SSB

<table>
<thead>
<tr>
<th>Term</th>
<th>Activity</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fall 2012</td>
<td>201210</td>
<td></td>
</tr>
<tr>
<td>Spring 2012</td>
<td>201230</td>
<td></td>
</tr>
<tr>
<td>Summer 2012</td>
<td>201250</td>
<td></td>
</tr>
<tr>
<td>Fall 2013</td>
<td>201310</td>
<td></td>
</tr>
<tr>
<td>Spring 2013</td>
<td>201330</td>
<td></td>
</tr>
<tr>
<td>Summer 2013</td>
<td>201350</td>
<td></td>
</tr>
<tr>
<td>Fall 2014</td>
<td>201410</td>
<td></td>
</tr>
<tr>
<td>Spring 2014</td>
<td>201430</td>
<td></td>
</tr>
<tr>
<td>Summer 2014</td>
<td>201450</td>
<td></td>
</tr>
</tbody>
</table>

Need Help with your Forms?

Robert Wagner - rw39@txstate.edu  5-3811
Melissa Hyatt – mh07@txstate.edu  5-2727
Martha Fraire-Cuellar - mf29@txstate.edu  5-1756

Need to Reset Password?

Call ITAC 245-ITAC
www.tr.txstate.edu/itac.html
FERPA

The Family Educational Rights & Privacy Act of 1974

Protects the Privacy of Student Education Records

Guarantees students’ access to their own records.
What is FERPA?

• Federal Law
  • Governs the rights of students and institutional responsibilities with respect to student records

• FERPA Governs
  • The release of education records maintained by Texas State University
  • The privacy of student education records
  • Student’s rights to access their education records

FERPA Workshop Outline

• Education Record
• Directory Information
• Protect Your Work Area
• Need to Know Basis
• Parental Access
What is an Educational Record?

May NOT be Released without a Student’s Written Consent

Education Records

- Grades
- Transcripts
- Student Schedules
- Papers
- Tests
- Test Scores
- Disciplinary Records
- Personally Identifiable Information

Exemptions

- Sole Possession Records
  - Documents used for your own personal memory aid

Directory Information

Can be Released Unless Student Request a Privacy Hold

The right to know the types of personally identifiable information that Texas State deems directory information that it may release without consent. Texas State has designated the following information as directory information:

1. Name
2. Date and Place of Birth
3. Fields of Study, including major and minor
4. Enrollment Status
5. Degrees, Certificates and Awards received
6. Type of Award received
7. Dates of Attendance
8. Student Classification
9. Most recent school attended
10. Telephone Number
11. Current and Permanent Addresses (excluding e-mail)
12. Weight and Height of athletes
13. Sports Affiliation
14. Names of prospective graduates
15. Parking permit records
16. Names of Parents
17. Photographs of students
18. Any other records that could be treated as directory information under FERPA

Caution:

If the student requests a Privacy Hold directory information can not be released without their written consent.
Not Considered Directory Information

- Gender
- Social Security Number
- E-mail Addresses

Who Must Comply?

All Offices
- Registrar’s Office
- Admissions Office
- Financial Aid
- Student Business Services
- Academic Departments
- Dean’s Office
- Auxiliary Departments

All Employees
- Faculty
- Staff
- Advisors
- Student Workers
Who’s Considered a Student?

FERPA applies to any individual who is or has been in attendance

• Residence Courses
• Off-campus Sites
• Outreach and Distance Education

When does Attendance Begin?

Once their name appears on a class roster.

Any individual who is registered for the current or a future semester by official registration methods and appears on a class roster is considered in attendance and a student.
What is Considered a Record?

Any information maintained in any way, including, but not limited to:

• Banner Student
• Banner Document Management System (BDMS)
• Cognos
• E-mails
• Handwritten Documents
• Computer Generated
• Microfilm and Microfiche

Protect Academic Records

Work Area:
• Protect Documents
  • Cover or turn over all documents with student information
• Secure Documents
  • Do not allow anything confidential to be removed from your work area either physically or mentally

Computer:
• Minimize
  • Banner Student
  • BDMS
  • Cognos
  • E-Mails
**Need to Know Basis**

**Legitimate Educational Use Only**

**Need to Know Basis Only**
- If it does not pertain to performing your office duties, do not look
- Just because you are “interested” in their records is not “Need to Know Basis”

---

**Parental Access**

There are three options:

- The student can give their parent access through Self Service BANNER to view their information. (This action requires the student’s PIN and Password which must be given to the parent by the student.)

- The student can provide the parent with written consent. [Grant Access to Student Records Form](#) (formerly [Student Authorization Release Form]*)

- The parent can provide proof that the student is carried as a dependent on the parent’s income tax return by filling out a [Parental Affidavit of Dependency Form]* in order to obtain the student’s academic information.

*This document is required each time information is requested.*
FERPA Links

FERPA – Faculty/Staff Link:
http://www.registrar.txstate.edu/persistent-links/ferpa/faculty-staff.html

FERPA – Registrar’s Office Link:
http://www.registrar.txstate.edu/persistent-links/ferpa.html

For More Information

Family Policy Compliance Office
US Department of Education
600 Independence Ave, SW
Washington, DC 20202-4605

FERPA – Registrar’s Office Link:
http://www.registrar.txstate.edu/persistent-links/ferpa.html
I request that Texas State University not disclose my directory information to others unless such disclosure otherwise meets the requirements of the Family Educational Rights and Privacy Act (20 U.S.C. § 1232g).

I understand that Texas State has designated the following information as directory information:
1) Name;
2) Date and place of birth;
3) Fields of study, including major and minor;
4) Enrollment status (actual hours enrolled, undergraduate, graduate, etc.)
5) Degrees, certificates and awards received;
6) Type of award received (academic, technical, continuing education, etc.)
7) Dates of attendance;
8) Student classification;
9) Name of the most recent previous educational agency or institution attended;
10) Telephone number;
11) Current and permanent addresses, excluding e-mail addresses;
12) Weight and height of athletes;
13) Participation in officially recognized activities and sports;
14) Names of prospective graduates;
15) Parking permit records;
16) Names of parents;
17) Photographs of students; and
18) Any other records that could be treated as directory information under FERPA.

I understand that I must file this privacy hold with the Registrar’s office by:
(1) the 12th class day during the Fall and Spring Semesters; and
(2) the 4th class day during a Summer Session.

I understand that this privacy hold will remain in effect until I request, in writing, that it be removed.

I understand that by signing and filing this form with the Registrar’s Office the university will not:
- release my directory information to outside persons, including prospective employers, insurance companies, and credit agencies;
- allow me to reset my PIN number by phone or receive directory information about myself by phone;
- publish my directory information in a student directory.

I also understand that if anyone requests directory information about me in person or by fax, phone, mail, or e-mail, the Registrar’s Office will respond, “We are unable to release any information that we may have on that individual.”

Please check one option below:

| PLACE – privacy/directory hold on my records at Texas State |
| REMOVE – privacy/directory hold from my records at Texas State |

Student Signature Date
Grant Access to Student Records
FERPA: The Family Educational Rights and Privacy Act

FERPA is a Federal Law designed to protect the privacy of a student’s education records. The Law applies to all institutions of higher education which receive funds under applicable programs of the U.S. Department of Education. This act protects your personal information from unauthorized distribution to third parties. With limited exceptions, Texas State University-San Marcos must have a signed acknowledgement from you before personal information can be released to a third party (i.e. spouse, parent, employer, etc.).

Student Name: ________________________ TXST ID: A

This form is your signed consent for Texas State University to release the indicated educational records to the individual identified. One form is required per authorized individual. If you wish to revoke this authorization, you will need to fill out a Revoke Access to Student Records form http://www.registrar.txstate.edu/our-services/ferpa.html. Please fill out this form on-line, print, sign, and return to one of the offices indicated below. Once received, the document will be processed in 2 to 3 business days.

I ___________________________________ the undersigned, hereby authorize Texas State University-San Marcos to release the following educational records to the designated individual or entity listed below (check all that apply):

☐ Academic Records/Transcript [Advising Center/Registrar’s Office]
☐ Financial Aid Records [Financial Aid Office]
☐ Student Financial Records [Student Business Services]

Access to student records will only be granted to the individual listed below when they provide the password you assign. Be sure to give the password to the person identified below. The University will not release any of your information unless the authorized individual provides the password.

Please enter password: ________________________

Designated Individual/Entity

Name: _____________________________________________
Address: ____________________________________________
Phone: _____________________________________________
Relationship: ☐ Parent/Guardian  ☐ Spouse  ☐ Other_____________

By signing this authorization, I am waiving my rights of nondisclosure of my student records under FERPA to the person or entity specifically listed herein. I hereby release and hold harmless Texas State University-San Marcos from any and all claims and liabilities that may arise from my instructions, including unauthorized viewing of my information by unintended recipients of mail or fax transmissions. If I am a dependent for tax purposes, Texas State University-San Marcos may (but is not required to) release educational records to parents and legal guardians, regardless of my consent. This executed FERPA Release Form will be in effect and retained in my student records from the date indicated below until I notify Texas State University-San Marcos of a change using the Revoke Access to Student Records form http://www.registrar.txstate.edu/our-services/ferpa.html.

Student Signature:____________________________ Date: __________________

Please complete, print, sign, and return this form to the Registrar’s office, your Academic Advisor, the Financial Aid and Scholarships office. This form can be mailed to the following address:

Texas State University-San Marcos
Attn: Registrar’s Office
601 University Dr.
San Marcos, TX 78666

Note: Allow two business days for this form to be processed and appear on your student record.
FERPA: The Family Educational Rights and Privacy Act

FERPA is a Federal Law designed to protect the privacy of a student’s education records. The Law applies to all institutions of higher education which receive funds under applicable programs of the U.S. Department of Education. This act protects a student’s personal information from unauthorized distribution to third parties.

Student Name: ________________________ TXST ID: A

Under FERPA, Texas State University-San Marcos may (but is not required to) release any and all information to parents or legal guardians without the consent of the student, if the student is a dependent for tax purposes under IRS rules. To verify dependent status, please fill out the following affidavit and have it notarized by a Public Notary.

Date

Parent(s) or Legal Guardian(s) Name (please print)

Address

City, State, Zip

Student’s DOB

1. I am a parent of the Texas State University-San Marcos student listed above.
2. My child is a dependent as defined in Section 152 of the Internal Revenue Code of 1986.
3. I am requesting a copy of the records listed below.

Records Requested

The University will not release any student information unless the authorized individual provides the password below. Passwords are used to verify the identity of the person making inquiries on a student record.

Please enter password: ______________________

I understand this authorization, if exercised, will be valid until the end of the calendar year (December 31st) and must be resubmitted annually to remain in effect.

Affiant’s Signature

Sworn to and subscribed before me this ____________ day of ________________, ______.

Notary Public

Please complete, print, sign, and return this form to the Registrar’s office, your Academic Advisor, the Financial Aid and Scholarships office. This form can be mailed to the following address:

Texas State University-San Marcos
Attn: Registrar’s Office
601 University Dr.
San Marcos, TX 78666

Note: Allow two business days for this form to be processed and appear on your student record. Please retain a copy of this form for your records as passwords will not be released.
Revoke Access to Student Records
FERPA: The Family Educational Rights and Privacy Act

FERPA is a Federal Law designed to protect the privacy of a student’s education records. The Law applies to all institutions of higher education which receive funds under applicable programs of the U.S. Department of Education. This act protects your personal information from unauthorized distribution to third parties. With limited exceptions, Texas State University-San Marcos must have a signed acknowledgement from you before personal information can be released to a third party (i.e. spouse, parent, employer, etc.).

Student Name: ____________________________ TXST ID: A ____________

This form serves as your signed revocation of consent for Texas State University to release the indicated educational records to the individual identified below. One form is required per authorized individual. If you wish to reinstate this individual’s authorization, you will need to fill out another Grant Access to Student Records Form http://www.registrar.txstate.edu/our-services/ferpa.html. Please fill out this form on-line, print, sign, and return to one of the offices indicated below.

I _________________________________________ the undersigned, hereby revoke the authorization for Texas State University-San Marcos to release my educational records to the designated individual or entity listed below.

Individual/Entity

Name:_____________________________________
Address: ___________________________________
Phone: _____________________________________
Relationship: □ Parent/Guardian  □ Spouse  □ Other__

By signing this revocation, I am reinstating my rights of nondisclosure of my student records under FERPA to the person or entity specifically listed herein. I understand that if I am a dependent for tax purposes, Texas State University-San Marcos may (but is not required to) release educational records to parents and legal guardians, regardless of my consent. This executed FERPA Revocation Form will be in effect and retained in my student records from the date indicated below until I notify Texas State University-San Marcos of a change by filling out another FERPA Release Form http://www.registrar.txstate.edu/our-services/ferpa.html

Student Signature: ____________________________ Date: __________________

Please complete, print, sign, and return this form to the Registrar’s office, your Academic Advisor, the Financial Aid and Scholarships office. This form can be mailed to the following address:

Texas State University-San Marcos
Attn: Registrar’s Office
601 University Dr.
San Marcos, TX 78666

Note: Allow two business days for this form to be processed and appear on your student record.
FERPA: The Family Educational Rights and Privacy Act

FERPA is a Federal Law designed to protect the privacy of a student’s education records. The Law applies to all institutions of higher education which receive funds under applicable programs of the U.S. Department of Education. This act protects your personal information from distribution to third parties. With limited exceptions, Texas State University-San Marcos must have a signed acknowledgement from you before personal information can be released to a third party (i.e. spouse, parent, employer, etc.).

Student Name: ___________________________ TXST ID: A

This form is your signed consent for Texas State University to release the indicated educational records to the individual identified. One form is required per authorized individual.

I ___________________________ the undersigned, hereby authorize Texas State University-San Marcos to release the following educational records to the designated individual or entity listed below (check all that apply):

- ☐ Official Transcript
- ☐ Diploma

Designated Individual/Entity

Name: ____________________________________________

Address: ____________________________________________

Phone: ____________________________________________

Relationship: ☐ Parent/Guardian ☐ Spouse ☐ Other__________

By signing this authorization, I am waiving my rights of nondisclosure of my student records under FERPA to the person or entity specifically listed herein. I hereby release and hold harmless Texas State University-San Marcos from any and all claims and liabilities that may arise from my instructions, including unauthorized viewing of my information by unintended recipients of mail or fax transmissions.

Copy of Student’s photo ID must accompany this form to verify signature.

Student Signature: ___________________________ Date: ___________________
Banner Basics

Student Information System

Outline

- INB Structure (Internet Native Banner)
- Term Codes
- Banner Navigation
- Banner Naming Convention
- Forms
- SSB (Self-Service Banner)
Areas of Student Banner

- General Person
- General Student
- SSB
- Registration
- Academic History
- Admissions
- Catalog
- Class Schedule
- Accounts Receivable
- Financial Aid

INB Banner Structure
**INB Structure**

**Menus** – guide you through banner

- My Banner
- Banner
  - Student
  - Financial Aid
  - General
  - Texas Connection

**Forms** - Where you retrieve student information

- SPAIDEN General Person Identification
- SZAREGS Student Course Registration
- SAAADMS Admissions Application
- WOAHOLD Hold Information

**Terms**

<table>
<thead>
<tr>
<th>Academic Year</th>
<th>Term – Credit Activity</th>
<th>Semester</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>2012 – 2013</td>
<td>Fall 2012</td>
<td>201210</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Spring 2012</td>
<td>201230</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Summer 2012</td>
<td>201250</td>
<td></td>
</tr>
<tr>
<td>2013 – 2014</td>
<td>Fall 2013</td>
<td>201310</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Spring 2013</td>
<td>201330</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Summer 2013</td>
<td>201350</td>
<td></td>
</tr>
<tr>
<td>2014 - 2015</td>
<td>Fall 2014</td>
<td>201410</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Spring 2014</td>
<td>201430</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Summer 2014</td>
<td>201450</td>
<td></td>
</tr>
</tbody>
</table>

1st - 4th position:
- Represents the Academic Year
- Fall through Summer (September - August)

5th - 6th position:
- Represents the semester:
  - 10 = Fall
  - 30 = Spring
  - 50 = Summer
Navigation

- Navigation is the key in moving through Banner
  - Menu Bar (Pull down menus)
  - Icon Toolbar
  - Keyboard Shortcuts (F8, CTRL+PgDown)

- Navigation is the same through all modules
  - Key Block
    - ID, Name, Term, Subject, CRN
  - Go To…
    - Type in form name (SPAIDEN, WOAHOJL, etc.)
  - Next Block
    - Takes you into the body (blocks) of the form
    - Navigate to other blocks attached to form
  - Rollback
    - Goes back up to the key block
  - Save
    - Save information entered on form
  - Exit
    - X in top right corner
    - Exits out of current form, or Banner if on General Menu

Banner Navigation Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Keyboard</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Record</td>
<td>Record &gt; Next</td>
<td>Down Arrow</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Previous Record</td>
<td>Record &gt; Previous</td>
<td>Up Arrow</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Clear Record</td>
<td>Record &gt; Clear</td>
<td>Shift + F6</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Delete Record</td>
<td>Record &gt; Remove</td>
<td>F6</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Insert Record</td>
<td>Record &gt; Insert</td>
<td>F6</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Next Block</td>
<td>Block &gt; Next</td>
<td>Ctrl + Page Down</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Previous Block</td>
<td>Block &gt; Previous</td>
<td>Ctrl + Page Up</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Enter Query</td>
<td>Query &gt; Enter</td>
<td>F7</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Execute Query</td>
<td>Query &gt; Execute</td>
<td>F8</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Cancel Query</td>
<td>Query &gt; Cancel</td>
<td>Ctrl + Q</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Rollback</td>
<td>File &gt; Rollback</td>
<td>Shift + F7</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Save / Commit</td>
<td>File &gt; Save</td>
<td>F10</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Next Field</td>
<td>Field &gt; Next</td>
<td>Tab</td>
<td>None</td>
</tr>
<tr>
<td>Previous Field</td>
<td>Field &gt; Previous</td>
<td>Shift + Tab</td>
<td>None</td>
</tr>
<tr>
<td>Exit</td>
<td>File &gt; Exit</td>
<td>Ctrl + Q</td>
<td><img src="Image" alt="Icon" /></td>
</tr>
<tr>
<td>Select</td>
<td>File &gt; Select</td>
<td>Shift + F3</td>
<td>None</td>
</tr>
<tr>
<td>Direct Access</td>
<td>File &gt; Direct Access</td>
<td>F5</td>
<td>None</td>
</tr>
</tbody>
</table>
Icon Toolbar

Banner Naming Convention

<table>
<thead>
<tr>
<th>SAAADMS</th>
<th>SZAREGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>S Student</td>
<td>S Student</td>
</tr>
<tr>
<td>A Admissions</td>
<td>Z Registration (TCC)</td>
</tr>
<tr>
<td>A Application</td>
<td>A Application</td>
</tr>
<tr>
<td>ADMS</td>
<td>REGS Student Course Registration</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SCACRSE</th>
<th>SSASECT</th>
</tr>
</thead>
<tbody>
<tr>
<td>S Student</td>
<td>S Student</td>
</tr>
<tr>
<td>C Catalog</td>
<td>S Schedule</td>
</tr>
<tr>
<td>A Application</td>
<td>A Application</td>
</tr>
<tr>
<td>CRSE</td>
<td>SECT Schedule – course sections</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SOAPCOL</th>
<th>SGASTDN</th>
</tr>
</thead>
<tbody>
<tr>
<td>S Student</td>
<td>S Student</td>
</tr>
<tr>
<td>O Overall</td>
<td>G General Student</td>
</tr>
<tr>
<td>A Application</td>
<td>A Application</td>
</tr>
<tr>
<td>PCOL</td>
<td>STDN General Student Information</td>
</tr>
</tbody>
</table>
General Person Menu

SPAIDEN
S  Student
P  Person
A  Application
IDEN  Identification

Banner INB System
SPAIDEN form

Official Name
Previous Name/ID
Addresses
Phone Numbers
Emails
Emergency Contact
Biographical Info:
  Ethnicity Code
  Veteran Status
  Confidential Notation
  Deceased Notation
Self-Service Banner (SSB)

Questions?

SPAIDEN. Huh?
Security of Confidential and Sensitive Information
Appropriate Use and Security of Confidential and Sensitive Information

Due to the integration of Student modules in Banner, it is imperative that you understand the importance of records security in regard to the access you may have in Banner. You may be granted access to information beyond what you need to perform your assigned office duties, but you should adhere to only the areas you are responsible for. Your access into Banner has been granted based on job duties and it is your responsibility to ensure the information you have access to is used appropriately.

Because you have access to confidential information for currently enrolled and former students, it is important that you comply with and are aware of the FERPA Act of 1974 (Family Education Rights Privacy Act). All information, unless you have been given written consent from the student, should be used for legitimate educational purposes only.

Always as a precaution, below are some good standards you should always follow.

- Do not share your password(s) or store them in an unsecured manner.
- Do not leave your workstation unattended, it is your responsibility to keep any activity attached to your login id secured.
- Do not share any confidential and sensitive information with anyone, including colleagues, unless there it is to be used for business purposes.
- Do not leave any documentation that has any identifiable information pertaining to a student on your workstation without you being there to secure and protect it.
- ALWAYS, securely dispose of all documents, reports, screen prints, and/or handouts that contain confidential and sensitive information by destroying or shredding up those documents.

If and when, a student requests for our office to place a Privacy Hold on their record our staff is not allowed to release any information without a written consent.

Texas State has designated the following information as directory information:

- Name
- Date/Place of Birth
- Dates of attendance
- Enrollment status
- Names of prospective graduates
- Participation in officially recognized activities and sports
- Student classification
- Telephone number
- Photographs of students
- Previous education
- Weight and height of athletes
- Degrees, certificates and awards received
- Parking permit records
- Names of parents
- Fields of study
- Types of awards received
- Current and permanent addresses
- Any other record that could be treated as directory information under FERPA

Forms
Student Authorization Release Form
Parental Access Affidavit
Privacy Hold Form - To place or remove

FERPA – Registrar’s Office Link: http://www.registrar.txstate.edu/persistent-links/ferpa.html
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Banner Terminology</td>
<td>7</td>
</tr>
<tr>
<td>Banner Navigation Tips</td>
<td>8</td>
</tr>
<tr>
<td>Toolbar Icons</td>
<td>8</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>8</td>
</tr>
<tr>
<td>Semester Terms in Banner</td>
<td>10</td>
</tr>
<tr>
<td>Banner Naming Convention</td>
<td>11</td>
</tr>
<tr>
<td>Commonly used forms within Banner</td>
<td>11</td>
</tr>
<tr>
<td>Banner Student</td>
<td>12</td>
</tr>
<tr>
<td>INB System</td>
<td>12</td>
</tr>
<tr>
<td>Logging Into Banner</td>
<td>12</td>
</tr>
<tr>
<td>General Menu and Layout</td>
<td>12</td>
</tr>
<tr>
<td>Basic Navigation to a Banner Form</td>
<td>13</td>
</tr>
<tr>
<td>Using the folder menus</td>
<td>13</td>
</tr>
<tr>
<td>Direct Access</td>
<td>13</td>
</tr>
<tr>
<td>Key Blocks and Tabs</td>
<td>14</td>
</tr>
<tr>
<td>Key Block</td>
<td>14</td>
</tr>
<tr>
<td>Blocks/Tabs</td>
<td>14</td>
</tr>
<tr>
<td>Four General Navigation Methods for Tabs/Blocks</td>
<td>14</td>
</tr>
<tr>
<td>Banner Form Components</td>
<td>15</td>
</tr>
<tr>
<td>Wildcards</td>
<td>16</td>
</tr>
<tr>
<td>How to look up a student</td>
<td>16</td>
</tr>
</tbody>
</table>
### General Banner Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form</td>
<td>A form is where information will be viewed.</td>
</tr>
<tr>
<td>Key Block</td>
<td>The key Block is the top portion of a Banner Form; this is where you enter</td>
</tr>
<tr>
<td></td>
<td>key information such as the ID, name, CRN, and Term to bring up information</td>
</tr>
<tr>
<td></td>
<td>on the form.</td>
</tr>
<tr>
<td>Blocks</td>
<td>Blocks are the areas on the Form.</td>
</tr>
<tr>
<td>Tabs</td>
<td>On some forms within Banner, there are tabs – also known as blocks.</td>
</tr>
<tr>
<td></td>
<td>Select a tab to view the information affiliated with the tab.</td>
</tr>
<tr>
<td>Term</td>
<td>Fall, Spring and Summer Terms are set up with a unique naming process.</td>
</tr>
<tr>
<td>CRN</td>
<td>Each course section is generated a five digit number that identifies the</td>
</tr>
<tr>
<td></td>
<td>course section. The registration process uses the CRN.</td>
</tr>
<tr>
<td>Next Block</td>
<td>An icon located in the top icon menu of banner used to activate the</td>
</tr>
<tr>
<td></td>
<td>information on the form.</td>
</tr>
<tr>
<td>Previous Block</td>
<td>An icon located in the top icon menu of banner used to move backwards</td>
</tr>
<tr>
<td></td>
<td>to a previous block.</td>
</tr>
<tr>
<td>Roll Back</td>
<td>To move back to the Key Block area.</td>
</tr>
<tr>
<td>Save</td>
<td>To save information entered on a form.</td>
</tr>
<tr>
<td>Exit Form</td>
<td>To close out of the current form, click the large “X” (Exit) icon in the</td>
</tr>
<tr>
<td></td>
<td>top right corner.</td>
</tr>
</tbody>
</table>
Banner Navigation Tips

Navigate to and from blocks by using:

- Icons on the Toolbar
- Menu Bar
- Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Common Functions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Block</td>
<td>F5</td>
</tr>
<tr>
<td>Previous Block</td>
<td>F7</td>
</tr>
<tr>
<td>Rollback</td>
<td>F8</td>
</tr>
<tr>
<td>Select</td>
<td>F10</td>
</tr>
<tr>
<td>Print</td>
<td>X</td>
</tr>
</tbody>
</table>

Toolbar Icons

Menu Bar

Select Menu to view. Each menu item has a different set of drop down options to choose from. Some features may be grayed out based on functions available or not available on the current form.
<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Keyboard</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Record</td>
<td>Record &gt; Next</td>
<td>Down Arrow</td>
<td></td>
</tr>
<tr>
<td>Previous Record</td>
<td>Record &gt; Previous</td>
<td>Up Arrow</td>
<td></td>
</tr>
<tr>
<td>Clear / Delete Record</td>
<td>Record &gt; Clear or</td>
<td>Shift + F6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record &gt; Remove</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert Record</td>
<td>Record &gt; Insert</td>
<td>F6</td>
<td></td>
</tr>
<tr>
<td>Next Block</td>
<td>Block &gt; Next</td>
<td>Ctrl + Page Down</td>
<td></td>
</tr>
<tr>
<td>Previous Block</td>
<td>Block &gt; Previous</td>
<td>Ctrl + Page Up</td>
<td></td>
</tr>
<tr>
<td>Enter Query</td>
<td>Query &gt; Enter</td>
<td>F7</td>
<td></td>
</tr>
<tr>
<td>Execute Query</td>
<td>Query &gt; Execute</td>
<td>F8</td>
<td></td>
</tr>
<tr>
<td>Cancel Query</td>
<td>Query &gt; Cancel</td>
<td>Ctrl + Q</td>
<td></td>
</tr>
<tr>
<td>Rollback</td>
<td>File &gt; Rollback</td>
<td>Shift + F7</td>
<td></td>
</tr>
<tr>
<td>Save / Commit</td>
<td>File &gt; Save</td>
<td>F10</td>
<td></td>
</tr>
<tr>
<td>Next Field</td>
<td>Field &gt; Next</td>
<td>Tab</td>
<td>None</td>
</tr>
<tr>
<td>Previous Field</td>
<td>Field &gt; Previous</td>
<td>Shift + Tab</td>
<td>None</td>
</tr>
<tr>
<td>Exit</td>
<td>File &gt; Exit</td>
<td>Ctrl + Q</td>
<td></td>
</tr>
<tr>
<td>Select</td>
<td>File &gt; Select</td>
<td>Shift + F3</td>
<td></td>
</tr>
<tr>
<td>Direct Access</td>
<td>File &gt; Direct Access</td>
<td>F5</td>
<td>None</td>
</tr>
</tbody>
</table>
Semester Terms in Banner

Terms represent the academic year and semester. Term abbreviations are 6 characters long and consist of 2 parts:

<table>
<thead>
<tr>
<th>1st - 4th position</th>
<th>5th - 6th position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Represents the Academic Year</td>
<td></td>
</tr>
<tr>
<td>Fall through Summer (September - August)</td>
<td></td>
</tr>
<tr>
<td>Represents the semester:</td>
<td></td>
</tr>
<tr>
<td>10 = Fall</td>
<td></td>
</tr>
<tr>
<td>30 = Spring</td>
<td></td>
</tr>
<tr>
<td>50 = Summer</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Academic Year</th>
<th>Term – Credit Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Semester</td>
</tr>
<tr>
<td>2010 – 2011</td>
<td>Fall 2010</td>
</tr>
<tr>
<td></td>
<td>Spring 2011</td>
</tr>
<tr>
<td></td>
<td>Summer 2011</td>
</tr>
<tr>
<td>2011 – 2012</td>
<td>Fall 2011</td>
</tr>
<tr>
<td></td>
<td>Spring 2012</td>
</tr>
<tr>
<td></td>
<td>Summer 2012</td>
</tr>
<tr>
<td>2012 - 2013</td>
<td>Fall 2012</td>
</tr>
<tr>
<td></td>
<td>Spring 2013</td>
</tr>
<tr>
<td></td>
<td>Summer 2013</td>
</tr>
</tbody>
</table>
Banner Naming Convention

Position 1: Identifies the *system* which owns the form
Position 2: Identifies the *application module* which owns the form
Position 3: Identifies the *type* of form
Position 4-7: A *short description* of what the form is

**Example: SPAIDEN**

Position 1:  S  *System* is a Student application
Position 2:  P  *Application* is a Person
Position 3:  A  *Form* is an Application
Position 4-7: IDEN  *Form* is an Identification Form

Commonly used forms within Banner

<table>
<thead>
<tr>
<th>SAAADMS</th>
<th>SFAREGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>S  Student</td>
<td>S  Student</td>
</tr>
<tr>
<td>A  Admissions</td>
<td>F  Registration</td>
</tr>
<tr>
<td>A  Application</td>
<td>A  Application</td>
</tr>
<tr>
<td>ADMS Admissions Application</td>
<td>REGS  Student Course Registration</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SCACRSE</th>
<th>SSASECT</th>
</tr>
</thead>
<tbody>
<tr>
<td>S  Student</td>
<td>S  Student</td>
</tr>
<tr>
<td>C  Catalog</td>
<td>S  Schedule</td>
</tr>
<tr>
<td>A  Application</td>
<td>A  Application</td>
</tr>
<tr>
<td>CRSE Basic Course Information</td>
<td>SECT  Schedule – course sections</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SOAPCOL</th>
<th>SGASTDN</th>
</tr>
</thead>
<tbody>
<tr>
<td>S  Student</td>
<td>S  Student</td>
</tr>
<tr>
<td>O  Overall</td>
<td>G  General Student</td>
</tr>
<tr>
<td>A  Application</td>
<td>A  Application</td>
</tr>
<tr>
<td>PCOL Prior College Information</td>
<td>STDN  General Student Information</td>
</tr>
</tbody>
</table>
Banner Student

INB System
INB (Internet Native Banner) is the internal Student Information System access used by offices within the Texas State System. This system is accessed via the web.

Logging Into Banner
1. [https://inb.txstate.edu/forms/frmservlet?config=prod_webutil](https://inb.txstate.edu/forms/frmservlet?config=prod_webutil)
2. Enter your username and password (leave **Database** blank).
3. Click **Connect**.

General Menu and Layout

Each user will only see the forms they have access to according to their level of security. Double-click to expand each folder.

System links that are set by Banner administrators.

Personal Links that can be customized by the user.
Basic Navigation to a Banner Form

There are 2 ways to navigate to a Banner Form: Folder Menus and Direct Access.

Using the folder menus

1. Double click the Student folder. This will expand to show all the folders contained within the Student folder.

2. Double-click the General Person folder to expand all the files contained within the General Person folder.

3. Double-click the SPAIDEN file to open it in the main window.

Direct Access

Type the form name into the Go To… field and hit <ENTER>.
**Key Blocks and Tabs**

**Key Block**
- Top portion of the Form is called the Key Block area
- All information on the form relates to the Key Block data
- Enter in information such as Banner ID, Term, CRN, etc.

**Blocks/Tabs**
- The main body of the form
- Contains information pertaining to the student, course, course section, etc.
- Not all forms have Tabs

---

**Four General Navigation Methods for Tabs/Blocks**

- **Tab**
  - Click on the Tab: Current Identification, Alternative Identification, Address, Telephone

- **Icon Toolbar**
  - Click on the Next Block Icon
  - Click on the Previous Block Icon

- **Menu Bar**
  - Click Block on the drop-down menu
  - Click Next or Previous

- **Keyboard Shortcut**
  - Ctrl + Page Down (Next Block)
  - Ctrl + Page Up (Previous Block)
Banner Form Components

In this manual, SPAIDEN is used as an example of a typical Banner form within Banner Student. The basic set up of all forms is the same, except SPAIDEN has tabs; not all Banner forms have tabs.

1. Pull Down Menus
2. Icon Toolbar
3. Drop Down Menus [▼] (usually opens a pop-out window)
4. Student ID and name (Key Block area)
5. Tabs for more information (if available)
6. Block Area
7. Date and ID of person who created/updated this form
8. Error/confirmation/miscellaneous status messages
Wildcards

A wildcard is a special character that represents one or more characters. Use wildcard symbols in the search criteria. Wildcards can be used to search for partial names and ID numbers.

- % - represents multiple character search
- _ - represents a single character search

<table>
<thead>
<tr>
<th>Desired Results</th>
<th>Enter this criteria...</th>
</tr>
</thead>
<tbody>
<tr>
<td>All entries that contain ma</td>
<td>%ma%</td>
</tr>
<tr>
<td>All entries that begin with ma</td>
<td>ma%</td>
</tr>
<tr>
<td>All entries that end with ma</td>
<td>%ma</td>
</tr>
<tr>
<td>All entries that have a as a second character</td>
<td>_a%</td>
</tr>
</tbody>
</table>

How to look up a student

The following demonstrates 3 ways to bring up the student’s information. This process works on any Banner student specific form.

1. **By ID number** - Enter the ID number in the Student ID Field. The name will auto populate.

2. **Name Search** (using Wildcard if needed). Press <ENTER>.

The **ID and Name Extended Search** window will pop up. Click the [▼] menu to scroll through search results. Click on your choice to close window and return to original form (in this example, **SPAIDEN**) with chosen student’s information populated in the ID and name fields.
3. **Person search** (SOAIDEN). Click the [▼] and choose **Person Search** from pop up Option List window). This brings up **SOAIDEN** in your main window.

On **SOAIDEN**, enter the last name (or partial name) into the appropriate search fields. Press F8 or **Execute Query** in the Icon Toolbar to get results.

Depending on the amount of detail supplied in the search criteria, results will be displayed. Double click on your choice to close this screen, and return to original screen (in this example, **SPAIDEN**) with the selected student’s information populated in the in ID and Student Name fields.
Security of Confidential and Sensitive Information
Appropriate Use and Security of Confidential and Sensitive Information

Due to the integration of Student modules in Banner, it is imperative that you understand the importance of records security in regard to the access you may have in Banner. You may be granted access to information beyond what you need to perform your assigned office duties, but you should adhere to only the areas you are responsible for. Your access into Banner has been granted based on job duties and it is your responsibility to ensure the information you have access to is used appropriately.

Because you have access to confidential information for currently enrolled and former students, it is important that you comply with and are aware of the **FERPA Act of 1974** (Family Education Rights Privacy Act). All information, unless you have been given written consent from the student, should be used for legitimate educational purposes only.

Always as a precaution, below are some good standards you should always follow.

- Do not share your password(s) or store them in an unsecured manner.
- Do not leave your workstation unattended, it is your responsibility to keep any activity attached to your login id secured.
- Do not share any confidential and sensitive information with anyone, including colleagues, unless there it is to be used for business purposes.
- Do not leave any documentation that has any identifiable information pertaining to a student on your workstation without you being there to secure and protect it.
- ALWAYS, securely dispose of all documents, reports, screen prints, and/or handouts that contain confidential and sensitive information by destroying or shredding up those documents.

If and when, a student requests for our office to place a Privacy Hold on their record our staff is not allowed to release any information without a written consent.

Texas State has designated the following information as directory information:

- Name
- Date/Place of Birth
- Dates of attendance
- Enrollment status
- Names of prospective graduates
- Participation in officially recognized activities and sports
- Student classification
- Telephone number
- Names of parents
- Previous education
- Weight and height of athletes
- Degrees, certificates and awards received
- Fields of study
- Parking permit records
- Photographs of students
- Types of awards received
- Current and permanent addresses
- Any other record that could be treated as directory information under FERPA

**Forms**
- [Student Authorization Release Form](#)
- [Parental Access Affidavit](#)
- [Privacy Hold Form](#) - To place or remove

# Table of Contents

Introduction .................................................................................................................................................. 7

Viewing Student Information........................................................................................................................ 9
   Admissions Application Summary (SAASUMI) ........................................................................................ 10
   Prior College Summary (SOAPCOQ) ........................................................................................................ 11
   Test Score Information (SOATEST) .......................................................................................................... 12
   High School Information (SOAHSCH) ...................................................................................................... 12
   Attributes (SGASADD) ............................................................................................................................. 13

General Student Records ............................................................................................................................ 15
   Viewing a Student’s Information (SGASTDQ) ......................................................................................... 15

Programs | Majors | Minors ................................................................................................................................................... 17
   Updating a Program | Major | Minor | Concentration (SGASTDN/SZAREGS) .............................................................................................. 17
      Determining if the student is registered for the term being changed ................................................. 17
      Add a New Program ............................................................................................................................ 18
      Add a Major | Minor | Concentration | Certification | Options ................................................................ 19
      Change a Major in a Different Program .............................................................................................. 20
      Adding a Minor | Concentration | Certification | Options .................................................................. 21
      Change a Major | Minor | Concentration | Certification | Options within the same Program ............ 22

Assigning Advisor ........................................................................................................................................ 23
   Adding or Changing Advisor Information (SGAADVR) ............................................................................ 23

Attributes .................................................................................................................................................... 25
   Entering Additional Student Information (SGASADD) ............................................................................ 25
      Adding Attributes ................................................................................................................................ 25
      Removing Attributes ............................................................................................................................... 25

Class Schedule ............................................................................................................................................. 29
   Schedule Section Query Form (SSASECQ) ............................................................................................... 31
   Schedule Form (SSASECT) ....................................................................................................................... 32
   Enrollment Counts and Details (SSASECT) .............................................................................................. 33
   Updating Maximum Enrollment (SSASECT) ............................................................................................ 34
   Waitlisting (SSASECT) ............................................................................................................................ 35
Introduction

Course goal

The goal of this workbook is to provide Departmental Users with the knowledge and practice to manage and register students.

Course Objectives

In this course you will learn how to:

- Manage General Student Records
- Use Class Schedule
- Use Self-Service Banner (SSB)

Intended Audience

Chairs, Deans, Advisors and Departmental Administrators
Viewing Student Information

Section Goal

This section will introduce you to basic forms used in looking up general student information such as classification, enrollment, school and test history, previous transcripts and attributes.

Objectives

In this lesson, you will learn how to navigate and read the following student information forms:

- SAASUMI
- SOAPCOQ
- SOATEST
- SOAHSCHS
- SGASADD

From these forms you can view the following information:

- Student classification
- Rules applied to an application (regular admit, transfer, readmit, etc.)
- Decision codes
- View indexed documents through BDMS (such as transcripts)
- View previous college information
- View test scores
- View high school information
- View attributes
How can I tell if the application is Undergraduate or Graduate?

1. **Level - Undergraduate**
2. **Student Type - F (First Time)**
   - A first time Undergraduate is a freshman.

How can I tell what type of rules are applied to an application? The combination of Admission Type and Student Type together examples:

- **RE F** = regular freshman (has not graduated & 0 hours)
- **RE T** = transfer who has graduated from high school & has 30+ hours
- **RL T** = transfer who has graduated from high school & has <30 hours
- **SU R** = Readmit seeking a subsequent degree - look for PBAC attribute

The Decision code identifies what action has been taken. Some examples are:

- **AI** – Admit to Institution
- **DI** – Denied to Institution
- **WD** – Withdraw Application

Click on the BDMS icon to view that student's documents, such as high school transcripts.
When you click the BDMS icon (magnifying glass), the Application WebXtender will open in a new window displaying any supporting documents (if available) for that student. Double-click the page icon to view the document.

Prior College Summary (SOAPCOQ)

SOAPCOQ is a query only form that allows you to view a student’s prior college information.
Test Score Information (SOATEST)
SOATEST displays all the student's test scores.

High School Information (SOAHSCH)
SOAHSCH displays the student's high school information.
Attributes (SGASADD)

SGASADD allows you to view attributes that have been assigned to a student for a given Term.

Typical Attributes

- **FLNG** – Foreign Language Satisfied
- **COSC** – Computer Science Satisfied
- **EMST** – Emerging Stars
- **ATHS** – Scholarship Athlete
- **PBAC** – Post Bachelor
General Student Records

Section Goal

The purpose of this section is to explain the process and detail the procedures for Departmental Users to use the general student forms in Banner.

Objectives

In this lesson you will learn how to:

- view a student’s information
- change, add or delete a program major, minor, concentration, certificate, or option
- add or change advisor information

Viewing a Student’s Information (SGASTDQ)

The General Student Summary Form (SGASTDQ) is a stand-alone query only form that displays all general student records on file for a student from the term displayed in the Key Block area (the top part of the form). The person must be a student to be queried on this form. If a term is entered in the Term field of the Key Block area, those student records with a term that is earlier in time or is equal to the term in the Key Block area will be displayed. If no term is entered in the Key Block area, all of the student's General Student records will be represented on the form back to the earliest record on file.

When working in SGASTDQ, the user may access the General Student Form (SGASTDN) a number of ways:

- **F5** brings up the Direct Access window. Type SGASTDN in the Go To... field and hit <ENTER>.
- From the Menu Toolbar select **Options>Detailed Student Information (SGASTDN)**
- From the Menu Toolbar select **Query>Count Hits** from any existing record. The user will view the record on SGASTDN that matches the record on which the cursor was placed in SGASTDQ when this function was performed.
To view your student’s information:

1. Access the General Student Summary Form (SGASTDQ).
2. Enter the ID of the student in the ID field.
   
   **Note:** If you have forgotten the ID of your student, click the ▼ to bring up SOAIDEN to do a name search for your student. Double-click your results to return to SGASTDQ.
3. Enter a term in the Term field.
   
   **Note:** The query will return information for the term you entered plus any previous terms that contain information for this student. You can enter information in the other fields in the key block area to narrow your search results.
4. Click **Next Block**.
5. Use the scroll bar, if necessary, to review the student’s record.
6. Select **Detailed Student Information** from the Options menu to access the General Student Form (SGASTDN).
7. Click **Exit** to close SGASTDN and return to SGASTDQ.
8. Click **Exit** to close SGASTDQ.
There are two different forms that can be used to accomplish these tasks – SGASTDN and SZAREGS.

The process is the same for both forms, but you must determine which form to use. You must check SGASTDN first to see if the student is registered for the term you are attempting to make the change:

- If a student IS NOT registered for the term to be changed – use SGASTDN
- If a student IS registered for the term to be changed – use SZAREGS

The General Student Form (SGASTDN) is used to maintain current and historical information about a student. The steps used to change a curriculum, major, minor or concentration to another depends on what other curriculum data currently exists for the user and whether the new major, minor or concentration exists within the existing curriculum or not.

**Determining if the student is registered for the term being changed**

1. Go to SGASTDN.
2. Enter ID of student.
3. Enter Term to be changed.
4. Click **Student Summary** (Opens SGASTDQ).

On SGASTDQ, look under the Student Summary block area to see if the term you are attempting to change is listed. If it is (as seen in the example below) then the student IS registered for that term. You will need to use SZAREGS. If you do not see that term, you can use SGASTDN. **Click the X to close.**
Add a New Program

1. Access SGASTDN.
2. Enter the Student ID.
3. Enter Term to be changed.
4. Click Next Block to activate the form.
5. Access the Curricula tab.
6. Under the Curricula tab, access the Curriculum tab.
7. Click the Replace icon. This will blank out most of the fields below.
   Note: If you see this error message at the bottom of the SGASTDN form then you must access SZAREGS to perform this function.
8. In the Program field, click the [▼].
9. From the pop up Option List window, choose Change Curriculum.
10. A warning box will appear: “Base Curriculum Items will be Replaced.” Click OK.
11. Choose the desired program from the Change Curriculum options window, and click OK.
12. Click Save.
Add a Major | Minor | Concentration | Certification | Options

1. Under the **Curricula** tab, click the **Field of Study** tab.
   - Since Major is auto populated in the Type box, if adding/changing a Major, skip to step 4
   - If adding a minor, concentration or certification, perform and repeat steps 2 and 3 as necessary.

2. In the **Field of Study** block, click the [▼] in the first blank **Type** field.

3. In the **Learner Field of Study Type** pop up box, choose one of the following:
   - Certification
   - Concentration
   - Major
   - Minor
   - Option
4. In the **Field of Study** field, click the [▼].
5. In the pop up Option List window, click on **Attached Majors**: (If available, *always* choose “attached” – this will ensure you are making a valid selection within the chosen Program.)
6. In the Department field, click the [▼] to choose the appropriate department.
7. If additional major/minors etc. are to be added, use the keyboard’s down arrow to go down to the next record.
8. Click OK.

**Change a Major in a Different Program**
1. Access the General Student Form (SGASTDN).
2. Enter the student ID.
3. Enter the term in the Term field.
4. Click Next Block.
5. Access the **Curricula** tab.
6. Click the **Replace** icon while on the curriculum row to be inactivated (it must currently be active and the most recent record for the priority).
   *Result*: The icon inactivates the curriculum row and inserts a new curriculum row for the new curriculum record. You are now on Record 2 of 2.
7. Complete these fields: **Priority**, **Program**, **Level**, **Campus** (optional), **Degree** and **College**.
8. Access the **Field of Study** tab.
9. Complete these fields: **Priority**, **Type** (Major, Minor or Concentration), **Status** (if other than the default), and **Field of Study** for the new major.
   Note: At least one active row with Type = Major must exist. Without a major, you will not be able to save the record.
10. Click **Save**.
Adding a Minor | Concentration | Certification | Options

1. Access SGASTDN/SZAREGS.
2. Enter the Student ID.
3. Enter Term to be changed.
4. Click Next Block to activate the form.
5. Access the Curricula tab.
6. Go to the Field of Study tab.
7. Use the arrow down key on the keyboard to activate a blank entry point.
8. In the Type field, click the [▼] to access the “Learner Field of Study” option box. Choose “MINOR” (or other category as necessary) as the category type from this window. Click OK.

9. In the Field of Study area, choose the new appropriate minor (or concentration/certification/option) using the [▼].

10. Add the appropriate Department from the Department [▼].
   Note: At least one active row with Type = Major must exist. Without a major, you will not be able to save the record.
11. To add more minors, certifications, concentrations, and/or options, repeat steps 7-10 as necessary.
12. Click Save.
Change a Major | Minor | Concentration | Certification | Options within the same Program

Note: It is important to ensure that the major a student is being changed to is valid for the Program that the student is in. Appropriate combinations of major to program are established on the Curriculum Rules form (SOACURR).

1. Access SGASTDN/SZAREGS.
2. Enter the Student ID.
3. Enter Term to be changed.
4. Click Next Block to activate the form.
5. Access the Curricula tab.
6. Go to the Field of Study tab.
7. Use the arrow down key on the keyboard to activate a blank entry point.
8. Verify that the correct type is selected in the Type field using the ▼ (“major”, “minor”, etc.)
9. Choose the new major/minor using the ▼ in the Field of Study area.
10. Add the appropriate Department from the Department ▼.
    Note: At least one active row with Type = Major must exist. Without a major, you will not be able to save the record.
11. Click Save. ✅
Assigning Advisor

Adding or Changing Advisor Information (SGAADVR)

The Multiple Advisors Form (SGAADVR) allows a student to be associated with an unlimited number of advisors for an effective term range. It also allows the user to view a student’s existing advisors for an effective term range. A General Student record must exist to associate an advisor with a student. The user must designate a primary advisor if multiple advisors exist. If the primary advisor is deleted, the secondary advisor defaults into the primary place.

NOTE: The end user must have a Primary Indicator no matter how many advisors are attached. There are no defaults for this form.

Adding an advisor to a student’s record:

1. Access the Multiple Advisors Form (SGAADVR).
2. Enter the ID of the student in the ID field.
3. Note: If you have forgotten the ID of your student, click the down arrow to find your student.
4. Select a term in the Term field.
5. Click Next Block.
6. Select the down arrow in the ID field in the Advisor Information block.
7. Result: The Faculty/Advisor Query Form (SIAIQRY) opens.
8. Enter part of the advisor’s last name in the Last Name field.
9. Click Execute Query.
10. Double-click in the ID field to return the information to SGAADVR.
11. Select a code in the Advisor Type field.
12. Click the Primary Indicator checkbox to indicate that this is the student’s primary advisor.
13. Click Save.
14. Click Exit.
Attributes

Entering Additional Student Information (SGASADD)
The Additional Student Information Form (SGASADD) maintains cohort codes, as well as attributes, which are assigned to the student by effective term. The cohort information records and attributes can be created manually on this form or may be rolled from the Admissions module upon creating the student record. The person must be defined as a student for a term that is encompassed by the effective term range for that student on the General Student Form (SGASTDN).

Adding Attributes

1. Access the Additional Student Information Form (SGASADD).
2. Enter the ID of the student in the **ID** field.
3. Select a term in the **Term** field.
4. Click **Next Block** twice to access the **Student Attribute** block.
5. Note the “From Term” and “To Term” (read auto help line).
6. To add an attribute, determine if the “From Term” and “To Term” match the attribute you are wanting to add.
   a. If no other attributes are listed, select a code in the **Attribute Code** field by manually entering the code (if known) or selecting by using the [▼] and choosing from the list.
   b. If other attributes exist and you are adding a new attribute that may not span the existing terms, you must click the **Maintenance** button. **ALWAYS COPY ATTRIBUTE**, otherwise you will erase the existing attributes placed by other offices. However, if you are simply adding your attribute to the existing term, “copy” is not necessary.
7. Click **Save**.
8. Click **OK**.
9. Click **Exit**.

Removing Attributes

1. Select the effective Term you are removing from.
2. Next Block to the Student Attribute block.
3. Double check the “From Term” and “To Term”.
4. Click the **Maintenance** button.
5. Choose **Copy**.
6. Select/highlight **YOUR** attribute, and from the menu select **Record>Remove**.
7. **Save**.

Typical Attributes:
- FLNG - Foreign Language
- COSC – Computer Science
- EMST – Emerging Stars
- ATHS – Scholarship Athlete
- PBAC – Post Bachelor
The image shows a section of a student management software interface. It contains sections for **Student Cohort** and **Student Attribute**. The **Student Cohort** section has a cohort code and a description field. The **Student Attribute** section displays attribute codes such as EMST (Emerging Stars) and HONR (Honor Student). The interface includes fields for entering data and options for maintenance and reason codes.

The software interface includes a warning that the term has been changed to remove the HONR from Fall 2012. The user is instructed to click the Maintenance button and then the Maintenance button is highlighted.

The software interface is used for managing student data, with specific fields for cohort codes, descriptions, and attributes. The interface is designed to be easily navigated by users within the department.
Note that the From Term has changed Fall 2012 (201310) and now will go to the end of time (999999).

Now we can "Remove Record" on the HONR field. Starting Fall 2012 Sarah will not carry the Honors attribute and save.
Once you save note the "Transaction complete at the bottom of the form."

If we go back and change the term in the Key Block to Fall 2011 (201210), we can see that the student attributes in the Student Attribute Block: EMST and HONR now run from Fall 2011 (201210) up to but not including Fall 2012 (201310).
Section goal

The purpose of this section is to explain the process and detail the procedures to use class schedule. This process is for Chairs and Deans Only.

Objectives

In this lesson you will learn how to:

• Look up CRN and section detail
• Review enrollment counts
• Update max enrollment
• Activate and maintain waitlists
• Update assigned instructor(s)
• Update Special Approval
• Identify linked sections
• Update course and section comments
• Registration overrides
• Assign and release holds

Forms associated with Class Schedule:

<table>
<thead>
<tr>
<th>Form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSASECQ</td>
<td>Used to query course section details.</td>
</tr>
<tr>
<td>SSASECT</td>
<td>Used to build and maintain the schedule of classes in the course catalog.</td>
</tr>
<tr>
<td>SSADETL</td>
<td>Used to view additional information for linked sections.</td>
</tr>
<tr>
<td>SSATEST</td>
<td>Used to view and update comments for a course that display in SSB.</td>
</tr>
<tr>
<td>SFASRPO</td>
<td>Used to manually place overrides on a student record to allow registration.</td>
</tr>
<tr>
<td>WOAHOLD</td>
<td>Used to assign and release holds on a student record.</td>
</tr>
</tbody>
</table>
Schedule Section Query Form (SSASECQ)

This is a schedule section query form. It is used to look up course sections. It will display Term, Part of Term, Registration dates, CRN, Subject, Course, Section, Campus, Title, Enrollment and other section details.

Steps to find a section CRN: (SSASECQ)

1. Access the Schedule Section Query Form (SSASECQ).
2. Enter the Term.
3. Tab over and enter Subject and Course (example: ENG 1310)
4. Press F8 or - this will execute the query and will pull up all active sections of ENG 1310.

Tip: Press your arrow down to see a Total Record Count (Number of Sections in this case)

Note:

- CRN (five digits) were formerly called Index Numbers (six digits)
- Sections numbers are no longer four digits long. Ex: Lab 1001 is now 101
Schedule Form (SSASECT)
The Schedule Form (SSASECT) is used to build and maintain the schedule of classes according to the definitions and restrictions created in the Course Catalog. A course catalog record (inventory) must exist prior to the creation of sections for a particular course as well as the term controls defined on the Term Control Form (SOATERM). From this form you can review:

- Course Section Information
- Section Enrollment Information
- Meeting Times and Instructor(s)
- Section Preferences

Steps to review course details:
1. Access the Schedule Form (SSASECT).
2. Enter the term in the Term field.
3. Enter the CRN assigned to the course in the CRN field.
4. Click Next Block. \(^\text{Note: Next Block}^\) will continue to take you through the different tabs.

**IMPORTANT:** If you are unable to activate a tab and receive this error: “Navigation was attempted to an item that is disabled or not valid; go to another item to continue. It may be necessary to use the mouse”, you will need to use the keyboard shortcut for Next Block: `CTRL+PgDown` to navigate to a tab.
Enrollment Counts and Details (SSASECT)

The Enrollment Details tab under Section Enrollment Information displays enrollment details. **Actual, Remaining, Generated Credit Hours, and Census One and Two Enrollment Count** fields will be populated with values as registration processing occurs over time.

**Steps to review enrollment counts:**

1. Access the Schedule Form (SSASECT).
2. Enter the term in the **Term** field.
3. Enter the CRN assigned to the course in the **CRN** field.
4. Click **Next Block.**
5. Click the **Section Enrollment Information** tab. Enrollment Details is the default tab view.
Updating Maximum Enrollment (SSASECT)

Use the Schedule Form (SSASECT) to review/update maximum enrollment for a course section.

**Steps to update maximum enrollment:**
1. Access the Schedule Form (SSASECT).
2. Enter the Term in the Term field.
3. Enter the CRN in the CRN field.
4. Click **Next Block.**
5. Select the **Section Enrollment Information** tab.
6. Update the **Maximum** field in the Enrollment Details block by clicking inside the field and typing the new maximum amount.
7. Click the **Save** button.
8. *Optional:* To repeat the process for another CRN, click **Rollback.**
9. When finished, click **Exit.**
Waitlisting (SSASECT)

You have the option of using the waitlist function for each section under the Section Enrollment Information>Enrollment Details tab. When a section is full, a student attempting to register for this section in Self-Service Banner will see the option to be placed on the waitlist. If a seat becomes available, the student will receive an email notification that they have 24 hours to register. This is on a first-come, first-serve basis.

Steps to set up waitlisting:

1. Access the Schedule Form (SSASECT).
2. Enter the Term in the Term field.
3. Enter the CRN in the CRN field.
4. Click Next Block.
5. Select the Section Enrollment Information tab.
6. Update the Waitlist Maximum field in the Enrollment Details block by clicking inside the field and typing the new maximum amount. Hint: Start off with 25% of typical enrollment.
7. Click the Save button.
8. Optional: To repeat the process for another CRN, click Rollback.
9. When finished, click Exit.
Viewing the Waitlist Priority Queue (SFAWLPR)

A student registering in Self-Service Banner who signs up for the waitlist of a section is placed on the Waitlist Priority Management form (SFAWLPR) for that section. Students are given a priority in the waitlist queue in order of registration (first-come, first-served.) This list will only accept as many students as the Waitlist Maximum number indicated in SSASECT for this section.

Steps to view students in the waitlist priority queue:
1. Access the Waitlist Priority Management form (SFAWLPR).
2. Enter the Term in the Term field.
3. Enter the CRN in the CRN field.
4. Click Next Block.

As seats are made available in the class, the next sequential student on the list will be removed from this form and placed on the Waitlist Notification form (SFIWLNT), and notified via email that they have 24 hours to register for the class. This is a query only form, so no changes can be made.
Monitoring Waitlist Notifications (SFIWLNT)

If a seat becomes available in a waitlisted class, the next sequential student is removed from the Waitlist Priority Management form (SFAWLPR) and placed on the Waitlist Notification Query form (SFIWLNT). The student will receive an email notification that they have 24 hours to register and assigned a status.

Steps to view waitlist notifications:
1. Access the Waitlist Notification Query form (SFIWLNT).
2. Enter the Term in the Term field.
3. Enter the CRN in the CRN field.
4. Click Next Block.

This is a query only form, so no changes can be made. However, you can view this form to track your waitlist notification activity. There are different waitlist statuses based on the student’s actions:

<table>
<thead>
<tr>
<th>Waitlist Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Has been notified; waiting for student to register</td>
</tr>
<tr>
<td>Registered</td>
<td>Has been notified; student registered for class</td>
</tr>
<tr>
<td>Dropped/Expired</td>
<td>Has been notified, but student did not register before the deadline</td>
</tr>
</tbody>
</table>

![Waitlist Notification Query Form]

When student signed up for waitlist or registered for the course
When student registered for the course
What order the student is on the waitlist
Student status - see table above
When student was notified via email
Date/time student has to register before offer expires
Updating Instructor (SSASECT)

You can update the instructors listed for a course section using SSASECT. An instructor must be listed on this form to view the roster.

1. Enter the Term in the Term field.
2. Enter the CRN in the CRN field.
3. Click Next Block.
4. Select the Meeting Times and Instructor tab.
5. Click Next Block again to access the Instructor block.

Note: If you are unable to access a tab and receive the error: "Navigation was attempted to an item that is disabled or not valid; go to another item to continue. It may be necessary to use the mouse", you will need to use the keyboard shortcut for Next Block: CTRL+PgDown to navigate.

To add an instructor:

6. Enter a new instructor on the next available line by entering the instructor’s A number into the ID field. If you need to perform a name search, click the drop down icon in the ID column. Remember that name searches are case sensitive.
   - **Primary Indicator**: If this is the primary instructor (or will be the only instructor) you must place a check mark in this check box.
   - **Override Indicator**: If you receive an error than an instructor has a schedule conflict (double-booked), you can override this by placing a check mark in this column.
7. Click Save.
To remove an instructor:

1. In the Instructor block, highlight the instructor to be removed by clicking on them.
2. Choose Record>Remove, or click the Remove Record icon.
3. Click Save.

Possible Errors:

*ERROR* Instructor Schedule Conflict, Press HELP for Available Instructors.

Cause/Solution:
Instructor is double booked. Select the “Override Indicator” checkbox and Save. This does not remove the instructor from other courses and they will remain double-booked.

*ERROR* Primary instructor must exist for section.

Cause/Solution:
If more than one instructor is listed, and/or primary instructor is not indicated, place a check mark in the Primary Indicator box accordingly and save.

*ERROR* Percent of responsibility and Percent of session must be entered.

Cause/Solution:
Percent of responsibility and/or session is not indicated for an instructor. Click in the field and adjust accordingly by typing in a value and save.

*ERROR* Person not an instructor, press LIST for instructors.

Cause/Solution:
Person is not an instructor or not on record for specified class. Please check with Faculty Records to ensure the instructor has been activated.

Cannot find my instructor when doing a name search

Cause/Solution:
Remember that name searches are case sensitive! Check with Faculty Records to ensure the instructor has been activated.
Special Approval (SSASECT)

You can assign special approvals for a course using SSASECT.

1. Enter the Term in the Term field.
2. Enter the CRN in the CRN field.
3. Click **Next Block**.
4. On the Course Section Information tab, click the Special Approval drop down icon to open the list of Special Approval Validation codes.
5. Select a code from the list and click **OK**.
6. Click **Save**.

### Special Approval Code

<table>
<thead>
<tr>
<th>Code</th>
<th>Student condition to allow course registration</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP Dept. Appr Needed (APPR)</td>
<td>Requires (APPR) override in SFASRPO</td>
</tr>
<tr>
<td>IN Instructor Approval Needed</td>
<td>Requires (INST) override in SFASRPO</td>
</tr>
</tbody>
</table>
Linked Sections (Lectures and Labs)

Many times we have lecture sections that have required lab sections. In order for the system to force the student to register in these specific combinations we must LINK sections. We do this by placing a code in SSASECT and SSADETL.

In this example, Lecture Biology 1421.001 is linked to Lab Biology 1421.135. When viewing in SSASECQ, you see the link identifier codes indicating each section is linked to another section. In this case, L1 and 1L are a reverse-matching pair:

<table>
<thead>
<tr>
<th>Course &amp; Section</th>
<th>SSASECT: Link Identifier</th>
<th>SSADELT: Link Connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIO 1421.001 (10157)</td>
<td>L1</td>
<td>1L</td>
</tr>
<tr>
<td>BIO 1421.135 (10208)</td>
<td>1L</td>
<td>L1</td>
</tr>
</tbody>
</table>

Note: Departments are responsible for providing the Registrar’s Office listings of the sections they want linked.
Link Identifiers and Connectors (SSASECT/SSADETL)

In our legacy system we used “Low Links and High Links” to match Lectures and Labs. In Banner we do this by placing Link Identifiers and Link Connectors.

The Link Identifier is placed in SSASECT and the Link Connector is placed in SSADETL. (Note: SSADETL is not an editable form, but you may use it to view and identify if there is an error on the link.)
Creating Section Comments (SSATEXT)

Use the Section Comment Form (SSATEXT) to enter or display comments associated with a section. Comments entered here appear on the Class Schedule Report (SSRSECT) and in SSB.

1. Enter the term in the Term field.
2. Enter the CRN in the CRN field.
3. Click **Next Block** twice 🔄 🔄 to activate the **Section Long Text** block.
4. Enter your text into the **Section Long Text** field. You may use html code as needed. Note: *there is no spellcheck feature!*
5. Click Save.

**Examples of html effects:**

<table>
<thead>
<tr>
<th>Html Effect</th>
<th>How you would type it into the field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add emphasis and links to Texas State University. (Bold the word “Add”.)</td>
<td><code>&lt;b&gt;Add&lt;/b&gt;</code> emphasis and links to Texas State University.</td>
</tr>
<tr>
<td>Add emphasis and links to Texas State University. (Italicize the word “emphasis”.)</td>
<td><code>&lt;i&gt;emphasis&lt;/i&gt;</code> and links to Texas State University.</td>
</tr>
<tr>
<td>Add emphasis and links to Texas State University. (Add a hyperlink to the university homepage and have it display as “Texas State University.”)</td>
<td>Add emphasis and links to <code>&lt;a href=&quot;http://www.txstate.edu&quot;&gt;Texas State University&lt;/a&gt;</code>.</td>
</tr>
</tbody>
</table>
Registration Overrides (SFASRPO)

1. Enter the ID of the student in the ID field. The student name will auto populate.
2. Select the appropriate term in the Term field.
3. Click **Next Block** to activate the screen with the student’s information. This may include existing overrides. The student’s schedule will appear in the bottom section of the screen.
4. Choose an override code from the Permit [▼] or enter a code manually. (See **Overrides Codes Chart** at the end of this section.)
5. Enter the CRN number of the course (the unique 5 character identifier of the course section) or search for Course Selection.

**TIP:** To allow the student to take **any** section of a course, enter the subject and course number, leaving off the CRN and section number (as shown in the example below using Honor courses.)

6. Click Save (or F10).

- Academic Registration Holds will not prevent an override to be set.
- Academic Registration holds will prevent the student from registering into those courses.
To search for all sections in subject:

1. On SFASRPO, enter Student ID or do a name search.
2. Enter appropriate Term.
3. Click **Next Block** to populate the form.
4. Go to **CRN** field and click the [▼].
5. On the pop-up Options List, select **Search for Sections (SFQSECM)**.
6. On SFQSECM, enter the subject code in the **Subject** field. Click F8 or [▼] to perform a query.
7. This will populate the form with all courses and sections in that subject. (Note: The scroll bar on the far right indicates if more choices are available by scrolling.)
8. Double click on course section to select course, close this window and return to SFASRPO.
9. Choose a permit/override code from the drop down menu or enter manually in the **Permit** field.
10. Click Save.

Changing an Override code

1. Highlight the permit code to be changed.
2. Re-enter the new code, or choose from the drop down menu.
3. Click Tab or Enter.
4. Click Save.

Removing an Override

1. Highlight the permit to be removed.
2. Choose **Record > Remove** or [▼].
3. Click Save.

Note: To change or remove a permit/override, make sure the appropriate term is selected.
Searching for a specific Course Selection (CRN)

1. Enter Student ID or perform a name search.
2. Enter appropriate Term.
3. Click Next Block.
4. Go to CRN field and click the ▼ icon.
5. Select Search for Sections (SFQSECM).
6. Click the ▼ under the Subject field to browse courses or enter search criteria in the Find field (refer to examples below).
7. Scroll through course sections, and click to highlight course section.
8. Double click on course section to select course, close this window and return to SFASRPO.

Multiple fields on SFQSECM can be searched:

Search by CRN, Part of Term, Subject, Course, Section, Available Seats, Campus, Schedule, Sections Status, Begin and End Time. Use wildcards in the Find window if needed:

- % - represents multiple character search
- _ - represents a single character search

<table>
<thead>
<tr>
<th>Desired Results</th>
<th>Enter this criteria...</th>
</tr>
</thead>
<tbody>
<tr>
<td>All entries that contain ma</td>
<td>%ma%</td>
</tr>
<tr>
<td>All entries that begin with ma</td>
<td>ma%</td>
</tr>
<tr>
<td>All entries that end with ma</td>
<td>%ma</td>
</tr>
<tr>
<td>All entries that have a as a second character</td>
<td>_a%</td>
</tr>
</tbody>
</table>
Examples of Searches

**Subject Only**
This will display all CHEM sections.

---

**Subject and Course**
This will display all CHEM 1341 sections.

---

**Subject and Link**
This displays all CHEM sections with a link attached. Registration MUST be entered for both the corresponding lecture and discussion sections.
## Override Codes

<table>
<thead>
<tr>
<th>Override Code</th>
<th>Description</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADVISOR</td>
<td>Advisor Approval Override</td>
<td>Advisor Approval is placed at the Section Level</td>
</tr>
<tr>
<td>APPR</td>
<td>Department Approval Override</td>
<td>Department Approval is placed at the Section Level</td>
</tr>
<tr>
<td>CHAIR</td>
<td>Chair Approval Override</td>
<td>Chair Approval is placed at the Section Level</td>
</tr>
<tr>
<td>CLASS</td>
<td>Classification Restriction Override</td>
<td>Classification Restriction is placed at the Catalog Level</td>
</tr>
<tr>
<td>CLOSED</td>
<td>Closed Class Approval Override</td>
<td>Allows user to give an override for a closed section</td>
</tr>
<tr>
<td>COLLEGE</td>
<td>College Restriction Override</td>
<td>College Restriction is placed at the Catalog Level</td>
</tr>
<tr>
<td>DEAN</td>
<td>Dean Approval Override</td>
<td>Dean Approval is placed at the Section Level</td>
</tr>
<tr>
<td>DEGREE</td>
<td>Degree Restriction Override</td>
<td>Degree Restriction placed at the Catalog Level</td>
</tr>
<tr>
<td>DEPT</td>
<td>Department Restriction Override</td>
<td>Allows user to give a permit for a course for which the student is already registered. <em>Example: ME 4000 may appear on the schedule twice in a specific term.</em></td>
</tr>
<tr>
<td>DUAL</td>
<td>Dual Enrollment Override</td>
<td>Allows user to give an Override for a course in which the student has reached the repeated limit. <em>Example: Music courses may be repeated for several hours. Once the student reaches &quot;max repeat&quot;, this override should be used</em></td>
</tr>
<tr>
<td>INST</td>
<td>Instructor Approval Override</td>
<td>Instructor Approval placed at the Section level</td>
</tr>
<tr>
<td>LEVEL</td>
<td>Level Restriction Override</td>
<td>Level Restriction is places at the Catalog Level</td>
</tr>
<tr>
<td>MAJOR</td>
<td>Major Restriction Override</td>
<td>Major Restriction is placed at the Catalog Level</td>
</tr>
<tr>
<td>PREREQ</td>
<td>Pre-requisite Restriction Override</td>
<td>Pre-requisites are placed at the Catalog Level</td>
</tr>
<tr>
<td>PROGRAM</td>
<td>Program Restriction Override</td>
<td>Program Restrictions are placed at the Catalog Level</td>
</tr>
<tr>
<td>REPEAT-HR</td>
<td>Repeat Hours Restriction Override</td>
<td>Allows user to give an Override for a course that was previously completed successfully by the student</td>
</tr>
<tr>
<td>REPEAT-LM</td>
<td>Repeat Limit Restriction Override</td>
<td>Allows user to give an Override for a course in which the student has reached the repeated limit. <em>Example: Music courses may be repeated for several hours. Once the student reaches &quot;max repeat&quot;, this override should be used</em></td>
</tr>
<tr>
<td>STUDENT</td>
<td>Student Attribute Override</td>
<td>Student Attribute Restrictions can be placed at the catalog or section level</td>
</tr>
<tr>
<td>TIME</td>
<td>Time Conflict Override</td>
<td>Allows override of time conflict</td>
</tr>
</tbody>
</table>
Assigning/Releasing Holds (WOAHOLD)

WOAHOLD is the form used in Banner to view and maintain all Academic Holds on students. The hold type will determine which restriction is on the student’s record. Users will only be able to place or remove holds that are applicable to their department.

How to view/place/remove holds:
1. Go to WOAHOLD.
2. Type the ID of the student.
3. Click Next Block to populate the screen.

To place a hold:
1. Select a Hold Type from the drop down menu, or type in the hold type code.
2. Type a reason for the hold being placed.
3. Set the hold active date in the “From” field.
4. Set the hold release date in the “To” field. This will default to 31-DEC-2099 if the hold release is contingent upon action from the student, and there is no definite release date otherwise.
5. Select your department from the Origination Code drop down.
6. Click Save.

Note: You will receive an error at the bottom of the screen if you attempt to place or remove a hold outside of your department permissions.
To remove a hold:

Change the “To” date to the date the hold should be removed. Entering “T” or “S” will auto fill the current date and remove the hold as well. Only the issuing department can remove a hold.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Hold Type     | • Determines what restrictions are listed on the student  
• Select hold type from drop down list  
• Refer to Hold Type legend to view additional hold types |
| Reason        | • Reason the hold was set  
• *Free form text that can be entered by the issuing department who placed the hold  
• Field is limited to 30 characters  
• Displays to the student in SSB |
| From Date     | • The beginning date the hold is active (Format: DD-MMM-YYYY)  
• Can be set to a future date; will not be active until that date.  
• Holds with a “From Date” listed in the future will not show up on the SSB system until the date that is listed. |
| To Date       | • The last date the hold is active (Format: DD-MMM-YYYY)  
• Default auto fill date is 31-DEC-2099  
• Can be changed; otherwise hold is in place until manually removed  
• To release hold, type release date **TIP:** Typing “T” or “S” into this field will auto fill current date *(issuing department only)* |
| Origination Code | • The department that placed the hold (select from drop down menu)  
• Only the issuing department can remove the hold  
• The person’s ID or batch process that set the hold is displayed above the department name |

*Note concerning free form text:

Each department should develop set Reason text to maintain consistency within the department and the Banner system. This text can be seen by the student and other departments.
## WOAHOLD Hold Types

<table>
<thead>
<tr>
<th>Hold Type</th>
<th>Description</th>
<th>What it Restricts</th>
<th>Hold Type</th>
<th>Description</th>
<th>What it Restricts</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>College Transcript</td>
<td>RE, TR</td>
<td>LB</td>
<td>Library Overdue Book</td>
<td>RE, TR</td>
</tr>
<tr>
<td>AD</td>
<td>Director of Admissions</td>
<td>RE, TR, AP</td>
<td>LG</td>
<td>Library General</td>
<td>RE, TR</td>
</tr>
<tr>
<td>AG</td>
<td>Admissions General</td>
<td>RE, TR</td>
<td>LI</td>
<td>Library Stolen ID</td>
<td>TR</td>
</tr>
<tr>
<td>AH</td>
<td>High School Transcript</td>
<td>RE, TR</td>
<td>NG</td>
<td>Athletics General</td>
<td>RE</td>
</tr>
<tr>
<td>AI</td>
<td>International Student</td>
<td>RE</td>
<td>NL</td>
<td>Laundry</td>
<td>RE, TR</td>
</tr>
<tr>
<td>AP</td>
<td>Admissions Provisionary</td>
<td>RE, AP</td>
<td>NN</td>
<td>NCAA Monitoring Hold</td>
<td>RE</td>
</tr>
<tr>
<td>AS</td>
<td>Test Scores</td>
<td>RE, TR</td>
<td>PP</td>
<td>Student Center Parking Garage</td>
<td>RE, TR</td>
</tr>
<tr>
<td>AT</td>
<td>Tuition Classification</td>
<td>RE</td>
<td>PT</td>
<td>Traffic</td>
<td>RE, TR</td>
</tr>
<tr>
<td>AV</td>
<td>Tuition Verification</td>
<td>RE</td>
<td>RG</td>
<td>Registrar General</td>
<td>RE, TR</td>
</tr>
<tr>
<td>CC</td>
<td>Health Center</td>
<td>RE, TR</td>
<td>SP</td>
<td>Paws Preview Hold</td>
<td>RE</td>
</tr>
<tr>
<td>DS</td>
<td>Disability Services</td>
<td>RE, TR</td>
<td>TA</td>
<td>Petty Cash Hold</td>
<td></td>
</tr>
<tr>
<td>EP</td>
<td>Procurement Card</td>
<td></td>
<td>TC</td>
<td>Collections Hold</td>
<td>RE, TR, AR</td>
</tr>
<tr>
<td>ET</td>
<td>Travel Card (termination only)</td>
<td></td>
<td>TE</td>
<td>Delinquent ETLP</td>
<td>RE, TR</td>
</tr>
<tr>
<td>FA</td>
<td>FA General Hold</td>
<td>RE</td>
<td>TH</td>
<td>TSI Hold</td>
<td>RE</td>
</tr>
<tr>
<td>GA</td>
<td>New Graduate App. Required</td>
<td>RE</td>
<td>TI</td>
<td>Installment Payment</td>
<td>RE, TR</td>
</tr>
<tr>
<td>GD</td>
<td>Graduate Degree Time Expired</td>
<td>RE</td>
<td>TL</td>
<td>Delinquent Short Term Loan</td>
<td>RE, TR</td>
</tr>
<tr>
<td>GE</td>
<td>Graduate Extended Admission</td>
<td>RE</td>
<td>TM</td>
<td>Misc. Accounting Hold</td>
<td>RE, TR</td>
</tr>
<tr>
<td>GG</td>
<td>Graduate General</td>
<td>RE</td>
<td>TN</td>
<td>Delinquent ETLP-Loan Collection</td>
<td>RE, TR</td>
</tr>
<tr>
<td>GS</td>
<td>Grad Scholarships Repayment</td>
<td>RE, TR</td>
<td>TO</td>
<td>No Checks Accepted</td>
<td></td>
</tr>
<tr>
<td>GT</td>
<td>Final Transcript for Grad Stud</td>
<td></td>
<td>TP</td>
<td>Perkins Loan</td>
<td>RE, TR</td>
</tr>
<tr>
<td>HC</td>
<td>Residential College Hold</td>
<td>RE</td>
<td>TR</td>
<td>Returned Item</td>
<td>RE, TR</td>
</tr>
<tr>
<td>HF</td>
<td>Residence Life Financial</td>
<td>RE</td>
<td>TS</td>
<td>Telephone Services Hold</td>
<td>RE, TR</td>
</tr>
<tr>
<td>HJ</td>
<td>Residence Life Judicial</td>
<td>RE</td>
<td>VA</td>
<td>Department Advising Hold</td>
<td>RE</td>
</tr>
<tr>
<td>HR</td>
<td>Housing Requirement</td>
<td>RE, AR</td>
<td>VG</td>
<td>General Academic Dept. Hold</td>
<td>RE</td>
</tr>
<tr>
<td>IO</td>
<td>International Office Hold</td>
<td>RE</td>
<td>VM</td>
<td>Change of Major Advising Hold</td>
<td>RE</td>
</tr>
<tr>
<td>IT</td>
<td>Instructional Tech Support Ho</td>
<td>RE, TR</td>
<td>VN</td>
<td>New Student Advising Hold</td>
<td>RE</td>
</tr>
<tr>
<td>JJ</td>
<td>Student Justice</td>
<td>RE</td>
<td>VP</td>
<td>Probation Advising Hold</td>
<td>RE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>VU</td>
<td>Undeclared Major Advising Hold</td>
<td>RE</td>
</tr>
</tbody>
</table>

### Restriction Type Definitions

- **Application (AP)**: Restricts the student from creating an admissions application
- **Accounts Receivable (AR)**: Restricts the student from paying for Tuition and Fees if account has been turned over to collections. TouchNET also restricts students from paying with ACH if they have outstanding returned items or if they have over 3 returned items in total.
- **Transcript (TR)**: Restricts the student from receiving a transcript in person or online
- **Registration (RE)**: Restricts the student from any registration process – adds, drops, and variable credit hour changes
Academic History

Section Goal

The purpose of this section is to show the user the different forms used to view various aspects of a student’s academic history.

Objectives

In this lesson you will learn how academic history is built and maintained and how to view different elements of a student’s academic history. We will go through each of the four forms and look at what information is offered in each one.

Banner maintains academic history on a student such as grades, grade changes, grade replacements, GPA by institution, term, or subject, degree sought, degrees awarded, graduation date, curricula, transfer work, academic standing, and dean’s list.

Grades and GPA are moved into Academic History once faculty members submit grades and the End of Term programs are processed. At that time grades are then rolled into Academic History. Once grades are rolled, all maintenance (grade changes, etc.) are maintained within Academic History.

Forms associated with Academic History:

<table>
<thead>
<tr>
<th>SHACRSE</th>
<th>Used to view academic transcript for a student; this form does not include the GPA.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHATERM</td>
<td>Used to view the academic GPA on a term-by-term basis.</td>
</tr>
<tr>
<td>SHASUBJ</td>
<td>Used to view the academic GPA on a subject-by-subject basis.</td>
</tr>
<tr>
<td>SHATRNS</td>
<td>Use to view students’ transfer work.</td>
</tr>
</tbody>
</table>
Course Summary (SHACRSE)

SHACRSE displays Texas State only courses and grades the student has completed for a specific term or for all terms. GPA’s are not displayed on SHACRSE.

1. Enter Student ID (or do a Name Search).
2. Enter Term (or leave blank to view all terms).
3. Click Next Block.

Queries

Queries can be performed on SHACRSE to search for courses by term, campus, level, subject, course, sections, repeat, and course title.

NOTE: Searches are case sensitive, but you can use wildcards.

- Press F7 to clear out all sections (or click the Enter Query icon).
- Enter your search criteria in the appropriate fields.
- Press F8 to execute the query (or click the Execute Query icon).
Term History (SHATERM)

SHATERM displays the student’s current academic standing, institution GPA, and Term GPA, and Course Detail Information. Use SHATERM to view a student’s GPA on a term-by-term basis. SHATERM is made up of two tabs: Current Standing and Term GPA and Course Detail Information.

The Current Standing Tab displays:

- First and Last Term attended
- Academic Standing
- Institution and Overall GPA

To view Current Standing information:

1. Enter Student ID (or perform a name search).
2. Enter Course Level Codes by Person (Click on ▼ to view all levels on the student).
3. Leave Term blank to display all Terms on Term GPA and Course Detail Information tab.
4. Click Next Block.

Course Level Codes by Person:

- CE – Continuing Education
- DR – Doctoral Professional
- GP – Graduate Post Bacc
- GR – Graduate/Masters
- NC – Non-Credit
- UG - Undergraduate

Current Standing

First Term Attended: [Term]
Last Term Attended: [Term]
Academic Standing:
Academic Standing Override:
Progress Evaluation:
Progress Evaluation Override:
Combined Academic Standing Override:
Combined Academic Standing:

<table>
<thead>
<tr>
<th>Institution</th>
<th>Attempted Hours</th>
<th>Passed Hours</th>
<th>Earned Hours</th>
<th>GPA Hours</th>
<th>Quality Points</th>
<th>GPA</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>120.00</td>
<td>120.00</td>
<td>120.00</td>
<td>120.00</td>
<td>388.00</td>
<td>3.03</td>
</tr>
<tr>
<td>Transfer</td>
<td>3.00</td>
<td>3.00</td>
<td>3.00</td>
<td>3.00</td>
<td>9.00</td>
<td>3.00</td>
</tr>
<tr>
<td>Overall</td>
<td>123.00</td>
<td>123.00</td>
<td>123.00</td>
<td>123.00</td>
<td>397.00</td>
<td>3.03</td>
</tr>
</tbody>
</table>
The **Term GPA and Course Detail Information** displays the term-by-term GPA by level. Use the scroll bar on the right to scroll through all terms (indicated by the arrow on the screenshot below.)

- Term GPA
- Institution Cumulative GPA
- Institutional Courses
  - Subject and Course
  - Course Title
  - Course Grade
  - Grade Mode
  - Credit Hours
  - Campus Code
  - Repeat Notation (Grade Replacement)

**Grade Mode:**
- S – Standard Grading
- X – Exclude from Grading
GPA by Subject (SHASUBJ)

SHASUBJ displays the student’s current academic standing, GPA by level, and Subject GPA and Course Detail Information. Use SHASUBJ to view student’s GPA on a subject-by-subject basis. SHASUBJ is made up of two tabs: Current Standing and Subject GPA and Course Detail Information.

The Current Standing Tab displays:

- First and Last Term attended
- Academic Standing
- Institution and Overall GPA

To view Current Standing information:

1. Enter Student ID (or perform a name search).
2. Enter Course Level Codes by Person (Click on ▼ to view all levels on the student).
3. Enter subject in Start with Subject field to search by subject. Leave blank to display all subjects.
4. Next Block twice or click the tab with your mouse.

The Subject GPA and Course Detail Information displays the subject-by-subject GPA by level. Use the scroll bar on the right to scroll through all terms (indicated by the arrow on the screenshot below.)
- Subject GPA
- Institutional Courses
- Transfer Courses
  - Subject and Course
  - Course Title
  - Course Grade
  - Grade Mode
  - Credit Hours
  - Campus Code
  - Repeat Notation (Grade Replacement)

**Grade Mode:**
- S – Standard Grading
- X – Exclude from Grading

<table>
<thead>
<tr>
<th>Subject</th>
<th>Course</th>
<th>Title</th>
<th>Grade</th>
<th>Mode</th>
<th>Hours</th>
<th>Quality Points</th>
<th>GPA</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACC</td>
<td>2562</td>
<td>INTRO TO MGR ACCTNG</td>
<td>B</td>
<td>S</td>
<td>3.000</td>
<td>63.00</td>
<td>2.20</td>
</tr>
<tr>
<td>ACC</td>
<td>2513</td>
<td>INTERMED ACCT I</td>
<td>C</td>
<td>S</td>
<td>3.000</td>
<td>9.00</td>
<td>3.00</td>
</tr>
<tr>
<td>ACC</td>
<td>2514</td>
<td>INTERMED ACCT II</td>
<td>X</td>
<td>S</td>
<td>0.000</td>
<td>72.00</td>
<td>2.20</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Term</th>
<th>Subject</th>
<th>Course</th>
<th>Title</th>
<th>Grade</th>
<th>Mode</th>
<th>Hours</th>
<th>Repeat</th>
<th>Campus</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007F</td>
<td>ACC</td>
<td>2561</td>
<td>INTRO TO FIN ACCTNG</td>
<td>B</td>
<td>T</td>
<td>3.000</td>
<td>(None)</td>
<td></td>
</tr>
</tbody>
</table>
Transfer Work (SHATRNS)

1. Enter **Student ID** or perform a name search.
2. Click on the [▼] in the Transfer Institution Number field. This will bring up a window that shows all transfer institutions available for this student.
3. Enter subject in **Start with Subject** field to search by subject. Leave blank to display all subjects.
4. **Next Block** twice to access the **Subject GPA and Course Detail Info** tab or click the tab with your mouse.

- **Transfer Institution Number**: Number associated with the Transfer Institution.
- **Attendance Period Number**: Number associated with the term at the Transfer Institution.
<table>
<thead>
<tr>
<th>Sequence Number</th>
<th>Subject</th>
<th>Course Number(s)</th>
<th>Hours</th>
<th>Grade</th>
<th>Group</th>
<th>Primary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Equivalent Course Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence Number</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Course Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
</tr>
<tr>
<td>CCCC</td>
</tr>
</tbody>
</table>
My Banner (GUAPMNU)

Section goal

The purpose of this section is to explain the process of building your My Banner menu.

Objectives

In this lesson you will learn how to save forms for easy access. My Banner (GUAPMNU) is a form used to save commonly used forms for easy access.

Steps to set up My Banner

1. Double-click on “My Banner” in the menu tree.
2. Double-click on Empty; Select to build. (Organize My Banner, after forms have been saved).
3. My Banner Maintenance (GUAPMNU) will open.
4. Type Form name under Object.
5. Tab to auto populate the Description field.
6. Continue adding forms as necessary.
7. Save.

You will have to log out and log back in to see your forms appear under My Banner.
Using Self-Service Banner (SSB)

Self-Service Banner (SSB) is a web-based application that students use to register for classes, pay tuition, check grades, update personal information and check financial aid and housing statuses. Faculty and advisors have access to SSB which allows them to view items such as class schedules, rosters, and other advising tools.

Student Self-Service

The Student Self-Service area is not limited to student-only functions. From this menu, faculty and advisors can access other tools and applications that are pertinent to their roles in the system.
Look Up Classes - See What the Student Sees
You are now able to see the same views a student sees when registering for classes, such as number of seats available, number registered, and number remaining.

1. Access the Faculty Services tab, and choose “Look Up Classes” from the menu options below.

2. Select the Term you wish to search from the drop down menu, and click Submit.
3. The Look Up Classes screen is presented to you in the same format the student sees when registering. You must select at least a subject, but all other search criteria is optional based on how narrow you want your search results to be returned to you.

4. Click **Search** at the bottom (or click ENTER) to return your search results.

5. The next screen displays all classes based on your search criteria. This example shows results based on searching for English in the Subject and 1310 for Course Number. From here you can see the status of the class (open/closed etc.), and current enrollment/open seats.
Override Errors

Please make sure you follow current policies when placing override/approvals in the system.

<table>
<thead>
<tr>
<th>Errors Students will see in SSB</th>
<th>Override Code Needed in SFASRPO</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dept Appr Needed (APPR)</td>
<td>APPR</td>
<td>Dept Approval Override</td>
</tr>
<tr>
<td>Chair/Director Approval Needed</td>
<td>CHAIR</td>
<td>Chair Approval Override</td>
</tr>
<tr>
<td>Class Restriction</td>
<td>CLASS</td>
<td>Classification Restriction Override</td>
</tr>
<tr>
<td>Closed Section (CRN)</td>
<td>CLOSED</td>
<td>Closed Class Approval Override</td>
</tr>
<tr>
<td>College Restriction</td>
<td>COLLEGE</td>
<td>College Restriction Override</td>
</tr>
<tr>
<td>Cohort Restriction</td>
<td>COHORT</td>
<td>Cohort Restriction Override</td>
</tr>
<tr>
<td>Degree Restriction</td>
<td>DEGREE</td>
<td>Degree Restriction Override</td>
</tr>
<tr>
<td>(DEPT) Restriction: See Dept where section is offered.</td>
<td>DEPT</td>
<td>Department Restriction Override</td>
</tr>
<tr>
<td>Duplicate Course with Section (CRN)</td>
<td>DUAL</td>
<td>Dual Enrollment Override</td>
</tr>
<tr>
<td>Instructor Approval Needed</td>
<td>INST</td>
<td>Instructor Approval Override</td>
</tr>
<tr>
<td>Level Restriction</td>
<td>LEVEL</td>
<td>Level Restriction Override</td>
</tr>
<tr>
<td>Major or Minor Restriction – (CRN)</td>
<td>MAJOR</td>
<td>Major Restriction Override</td>
</tr>
<tr>
<td>Prerequisite or Test Score error</td>
<td>PREREQ</td>
<td>Pre-requisite Restriction Override</td>
</tr>
<tr>
<td>Program Restriction</td>
<td>PROGRAM</td>
<td>Program Restriction Override</td>
</tr>
<tr>
<td>Student Attribute Restriction</td>
<td>STUDENT</td>
<td>Student Attribute Override</td>
</tr>
<tr>
<td>Time conflict with (CRN)</td>
<td>TIME</td>
<td>Time Conflict Override</td>
</tr>
</tbody>
</table>

Maximum hours exceeded error: Needs to be maintained in SZAREGS

**MGT INTERNSHIP - 17177 - MGT 4395 - 002**

**Department Approval Needed (APPR) Internship**

Associated Term: Fall 2011
Registration Dates: Mar 27, 2011 to Sep 08, 2011
Levels: Undergraduate
Instructors:

If your department requested that a section require a Special Approval then the comment "Department Approval Needed (APPR)" was placed in the comment.

Override Code: APPR

**LEADERSHIP & MGT I - 10008 - A S 3311 - 001**

**INSTRUCTOR APPROVAL NEEDED (INST)**

Associated Term: Fall 2011
Registration Dates: Mar 27, 2011 to Sep 08, 2011
Levels: Undergraduate
Instructors:

If your department requested that a section require a Instructor Approval then the comment "Instructor Approval Needed (INST)" was placed in the comment.

Override Code: INST
Each Restriction below has an option of being set up as a MUST BE or a MAY NOT BE, below are several examples of possible restrictions a course/section could have.

Restrictions:
Must be enrolled in one of the following Programs: Override Code: PROGRAM
Bachelor of Arts-BA
May not be enrolled in one of the following Levels: Override Code: LEVEL
Doctoral/Professional
Must be enrolled in one of the following Degrees: Override Code: DEGREE
Bachelor of Arts
Must be enrolled in one of the following Colleges: Override Code: COLLEGE
College of Liberal Arts
Must be enrolled in one of the following Fields of Study (Major, Minor, Concentration, Certification, or Option): Override Code: MAJOR
Marketing
May not be enrolled in one of the following Departments: Override Code: DEPT
Anthropology
Must be assigned to one of the following Cohorts: Override Code: COHORT
Teacher Cert
Must be assigned one of the following Student Attributes: Override Code: STUDENT
Round Rock Higher Ed Center
May not be enrolled as the following Classifications: Override Code: PROGRAM
Freshman
Sophomore

Prerequisites:
For Course + Number

General Requirements:
Course or Test: Course + Number
Required Courses: 1
Minimum Grade of D
May not be taken concurrently.
Prerequisites:
Texas State GPA 2.0 Required

General Requirements: 2.00000000 gpa.
1000 to 7999
Required Credits: 0.000
May not be taken concurrently.
Texas State University-San Marcos
Updating Hours Load

March 2011
Updating Hours Load (Quick Steps)

1. Access Banner: https://inb.txstate.edu/forms/frmservlet?config=prod_webutil
2. In the direct access box, go to SZAREGS.
3. Close the SOATEST window that appears.
4. Enter the Term.
5. Enter ID of the student.
6. Click Next Block.
7. You will receive a pop up error window – click OK.
8. In the Maximum box, enter the desired number of maximum hours.
9. Click “Execute Query” (F8).
10. A pop up window will ask “Do you want to save the changes?” Click Yes.
   - Note at the bottom left of the screen, the status will read: Transaction complete: 1 records applied and saved.”
11. To adjust another student:
   - Click Rollback
   - Repeat steps 5-10 as necessary.
1. Access Banner: https://inb.txstate.edu/forms/frmservlet?config=prod_webutil
2. In the direct access box, go to SZAREGS.

3. Close the SOATEST window that appears by clicking the X in the top right corner. SZAREGS will appear in your window.
4. Enter the Term.
5. Enter the ID of the student.

6. Click Next Block.

7. You will receive a pop up error window – click OK.
8. In the **Maximum** box, enter the desired number of maximum hours.

9. Click “Execute Query” (F8).

10. A pop up window will ask “Do you want to save the changes?” Click Yes.

- **Note at the bottom left of the screen, the status will read:** Transaction complete: 1 records applied and saved.”
11. To adjust another student:
   - Click Rollback
   - Enter ID of next student.
   - Repeat steps 4-10 as necessary.
Certifying Rosters
1. Browse to https://tim.txstate.edu/classrosters or click the Certify Rosters link on the Faculty Services tab.
2. Log in using your NetID and password.
3. The Home navigational menu on the left offers 2 selections:
   • Class Selection – displays all your classes on one screen; click class names to view each one.
   • Inquire Class Rosters – offers the option to view Student Photos in the roster.

Certifying Classes
1. Click Class Selection in the navigation menu on the left.
2. Under Faculty Classes, click a class name to open that class in the Roster Certification screen.
3. The roster status may be changed for a student by clicking Edit on their corresponding row.
   a. Within the Edit window, click Update when finished, or Cancel to back out of the changes.
   b. Repeat as necessary for individual students.
4. You may add a new student by clicking the “Add New Student” button at the top of the roster.
5. When you are finished, click the Certify Roster button to certify your roster.
6. Red text will appear: “Roster Certified Successfully” indicating your changes are complete.
7. To certify another class, return to the Class Selection screen and choose another class.
Certifying Classes and Picture Rosters

1. Browse to [https://tim.txstate.edu/classrosters](https://tim.txstate.edu/classrosters) or click the Certify Rosters link on the Faculty Services tab in SSB.

2. Log in using your NetID and password.

3. The Home navigational menu on the left offers 2 selections:
   - **Class Selection** – displays all your classes on one screen; click class names to view each one. Use this link to certify rosters.
   - **Inquire Class Rosters** – offers the option to view Student Photos in the roster.
Certifying Classes

1. The **Class Selection** screen displays the classes by term and by session for which you are responsible.
2. Under **Faculty Classes**, click a class name to open that class to review for certification.
3. The **Roster Certification** screen will be displayed for the selected class.

   **Roster Certification**

   ![Roster Certification Screen](image)

   - Session Code: 01
   - Course: 11267 CJ 2355
   - Location: HINE, ROOM-00207
   - Certification Begin Date: 8/1/2011 12:01:00 AM
   - Certification End Date: 9/20/2011 11:59:00 PM

4. The roster status may be changed for a student by clicking **Edit** on their corresponding row, expanding the edit box:

   ![Edit Box](image)

   a. Choose from Attending, Not Attending, or Pending from the drop down menu.
   b. Click **Update** when finished, or **Cancel** to back out of the changes.
   c. Repeat as necessary for individual students.
5. You may add a new student by clicking the “Add New Student” bar at the top of the roster to expand the window.

![Add New Student](image)

a. Enter the student’s Texas State ID number and click “Add Student”
b. The student’s name will be retrieved from Banner and added to the roster grid.

6. When you are finished, click the **Certify Roster** button to certify your roster.

7. Red text will appear: “Roster Certified Successfully” indicating your changes are complete.

![Class Roster](image)

8. To certify another class, return to the Class Selection screen and choose another class.